
Fayol Inc. 0547824419/0549566881 

SECOND TERM LESSON PLAN  

COMPUTING – B7 

WEEK 1 

Strand : Productivity Software   Week Ending: 13th MAY, 2022 

Sub Strand: Introduction to Word Processing Duration :50mins 

Content Standard: B7.2.1.1 Demonstrate how to use Microsoft Word Class : B7 

Indicators: B7.2.1.1.2. Demonstrate how to insert, select, delete and move text Day : 

Core competences: DL5.1: Ability to ascertain when information is needed and be able to identify, locate, evaluate and effectively use it to 

solve a problem. 

 

Activities For Learning & Assessment Equipment/Resources Learners Resource 

Page Ref. 

Progression  

Starter (5 mins) 

 

Recap with learners to review their understanding in the previous 

lesson. 

 

Introduce the lesson by sharing the performance indicators. 

 

 

 

Main (35 mins) 

Brainstorm learners to come out with the meaning of editing. 
Editing is the process of correcting mistake changes to the content of a 

document. 

 

Show projected examples of MS-Word interface with the aid of a 

computer, projector or pictures.  

Set of computer, Video 

/pictures  

 

Computing 

Curriculum Pg. 8-9 

Learning how to 

use insert text, 

move text, delete 

text, undo, redo 

and use the 

spelling & 

grammar check 



 

Guide learners to discuss the ways of editing a document. 

Example: inserting text, moving text, deleting text, undo, redo and 

spelling & grammar check. 

Demonstrate to learners, how to insert, move and delete text in a 

word document. 

Example: to insert text 
1. Move the insertion point to where you want to insert the text. 

2. Click to place the insertion point 

3. Start typing the text 

 

Learners practice how to use the undo, redo and spelling & 

grammar check tools for editing. 

 

Have learners to explore more tools for editing in MS Word. 

 

Explore the use of the overtype or insert option by right-clicking 

the status bar. 

 

 

Reflection (10 mins) 

We have learnt how to use spelling and grammar check as well as 

setting language preferences. 

  

Engage learners in a think-pair-share activity to practice how to 

spell and grammar check text in a passage.  

Homework/Project Work/Community Engagement Suggestions 

 What is editing? 

 State three ways of editing a word document. 

 Describe how to insert a text in a word document. 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory. 

 



  



Strand : Productivity Software   Week Ending: 13th MAY, 2022 

Sub Strand: Introduction to Word Processing Duration :50mins 

Content Standard: B7.2.1.1 Demonstrate how to use Microsoft Word Class : B7 

Indicators: B7.2.1.1.3-4. Demonstrate how to find and replace content and undo 

edited changes and demonstrate how to spell check, carry out content translation, 

language setting 

Day : 

Core competences: DL5.1: Ability to ascertain when information is needed and be able to identify, locate, evaluate and effectively use it to 

solve a problem. 

 

Activities For Learning & Assessment Equipment/Resources Learners Resource 

Page Ref. 

Progression  

Starter (5 mins) 

 

Recap with learners to review their understanding in the previous 

lesson. 

 

Introduce the lesson by sharing the performance indicators. 

 

 

 

Main (35 mins) 

 

Guide learners to make use of the Find and Replace tool in MS-

Word under the Home tab.  

 
 

Set of computer, Video 

/pictures  

 

Computing 

Curriculum Pg. 8-9 

Learning how to 

use Find and 

Replace tool in 

MS-Word, 
Proofing and 

Language group, 

Spelling & 

Grammar, 

Thesaurus 



 
 

Have learners to explore the use of the Editing group under the 

Home tab. 

 

Guide learners to demonstrate the use of the Proofing and 

Language group under the Review tab.  

 

 
 

Show how to use the Language, Spelling & Grammar, Thesaurus 

and other tools in MS-Word under the Home tab.  

 

 

Reflection (10 mins) 

We have learnt how to use replace tool in MS-Word, Proofing and 

Language group, Spelling & Grammar, Thesaurus. 

  

Engage learners in a think-pair-share activity to practice how to use 

replace tool in MS-Word and spell and grammar check text in a 

passage. 



Homework/Project Work/Community Engagement Suggestions 

 What is editing? 

 State three ways of editing a word document. 

 Describe how to insert a text in a word document. 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory. 

 

 



Fayol Inc. 0547824419 

WEEKLY LESSON NOTES – B7 

WEEK 2 

Strand : Productivity Software   Week Ending: 20th MAY, 2022 

Sub Strand: Introduction to Word Processing Duration :50mins 

Content Standard: B7.2.1.1 Demonstrate how to use Microsoft Word Class : B7 

Indicators: B7.2.1.1.5 Demonstrate how to use text-decoration, change text case, 

text size and color 
Day : 

Core competences: DL5.1: Ability to ascertain when information is needed and be able to identify, locate, evaluate and effectively use it to 

solve a problem. 

 

Activities For Learning & Assessment Resources Learners Resource 

Page Ref. 

Progression  

Starter (5 mins) 

 

Recap with learners to review their understanding in the previous lesson. 

 

Introduce the lesson by sharing the performance indicators. 

 

 

 

Main (35 mins) 

 

Guide learners to explore the use of the Font group under the Home tab. 

 

Quiz learners to mention some of the tools under the Font group. 

Example:  

Font style and Font size 

Bold, Italics and Underline 

Strikethrough 

Superscript and Subscript  

Set of computer, 

Video /pictures  

 

Computing 

Curriculum Pg. 8-9 
Learning how to 

use text-

decoration, 

change text case, 

text size and 

color in MS 

Word 



Increase and decrease font size 

 
 

 

Engage learners to demonstrate the use Bold, Italics, Underline 

Strikethrough, Superscript and Subscript in MS-Word. 

Example: 

 

The boy is going to school with his friends. 
 

 

4x4x4x4=44 

 

Two molecules of oxygen = O2 
 

Demonstrate the use of sentence case, font size, color and font decoration 

features in MS-Word 

Example:  

 

Chantal is an intelligent student. 

 

Changing the font style of a Text 

1. Highlight the text you want to change its font type. 

Bold  Strikethrough  Underline  Italics  

Superscript  

Subscript  



2. Click the font type list arrow and  

3. Select the font style of your choice from the list. 

Project examples of MS-Word interface to learners with the aid of a 

projector or pictures. 

 

 

 

Reflection (10 mins) 

We have learnt how to use replace tool in MS-Word, Proofing and Language 

group, Spelling & Grammar, Thesaurus. 

  

Engage learners in a think-pair-share activity to practice how to use replace 

tool in MS-Word and spell and grammar check text in a passage. 

Homework/Project Work/Community Engagement Suggestions 

1. Identify any five Editing tools you know. 

2. State the use of the following  

a. text-decoration,  

b. change text case,  

c. text size 

d. text color 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory. 

 

 

  



 

Strand : Productivity Software   Week Ending: 20th MAY, 2022 

Sub Strand: Introduction to Word Processing Duration :50mins 

Content Standard: B7.2.1.1 Demonstrate how to use Microsoft Word Class : B7 

Indicators: B7.2.1.1.6 Demonstrate how to align text, indent paragraphs, bullet, 

line space and shade 
Day : 

Core competences: DL5.1: Ability to ascertain when information is needed and be able to identify, locate, evaluate and effectively use it to 

solve a problem. 

 

Activities For Learning & Assessment Resources Learners Resource 

Page Ref. 

Progression  

Starter (5 mins) 

 

Recap with learners to review their understanding in the previous lesson. 

 

Introduce the lesson by sharing the performance indicators. 

 

 

 

Main (35 mins) 

 

Guide learners to explore the use of the Paragraph group, using the align 

left, center, align right and justified in MS-Word under the Home tab.  

Set of computer, 

Video /pictures  

 

Computing 

Curriculum Pg. 8-9 
Learning how to 
how to align text, 

indent 

paragraphs, 

bullet, line space 

and shade in MS 



 
 

Guide learners to explore the use of Bullets, Decrease and Increase 

Indentation under the Home tab.  

 

 

Guide learners to identify the use of the Border Button and set line spacing 

using the dialogue Box Launcher button under the Home tab.  

 
 

 

 

Reflection (10 mins) 

We have learnt how to use replace tool in MS-Word, Proofing and 

Language group, Spelling & Grammar, Thesaurus. 

  

Border button 

Line and Spacing 



Engage learners in a think-pair-share activity to practice how to use replace 

tool in MS-Word and spell and grammar check text in a passage. 

Homework/Project Work/Community Engagement Suggestions 

1. Identify any three Editing tools you know. 

2. State the use of the following  

a. align text  

b. indent  

c. paragraphs,  

d. bullet,  

e. line space and shade 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory. 

 



Fayol Inc. 0547824419 

WEEKLY LESSON NOTES – B7 

WEEK 3 

Strand : Productivity Software   Week Ending: 27th MAY, 2022 

Sub Strand: Introduction to Electronic Spreadsheet Duration : 

Content Standard: B7.2.3.1. Demonstrate how to use the Spreadsheet (Editing 

Worksheets) 
Class : B7 

Indicators:  B7.2.3.1.1. Explain the importance of electronic spreadsheet Day : 

Core competences: DL5.1: Ability to ascertain when information is needed and be able to identify, locate, evaluate and effectively use it to 

solve a problem. 

 

Activities For Learning & Assessment Resources Learners 

Resource Page 

Ref. 

Progression  

Starter (5 mins) 

Using questions and answers, revise with learners to find what they already 

know about electronic spreadsheet 
 

Share performance indicators and introduce the lesson. 

 

 

Main (35 mins) 

 

Brainstorm learners to discuss the meaning of electronic spreadsheet.  
A spreadsheet is a grid or table made from column and rows that is primarily used to work with 

numbers and text.  

 

Guide learners to launch the MS-Excel 
 Click on the start button to open the start menu. 

 Scroll down to locate the Microsoft Office folder 

 Click on the folder to open the drop down menu. 

 Click on Microsoft Office Excel. 

 

Computer with 

Microsoft Excel, 

mouse or 

touchscreen 

input device, 

projector 

Computing 

Curriculum Pg. 9-

10 

Learning the 
importance of 

electronic 
spreadsheet 



Discuss the benefits of using electronic spreadsheet software.  

Example:  
 It helps to maintain values 

 It helps us to represent values graphically by creating charts based on worksheet 

figures. 

 It is also used to create data summaries and short-lists using PivotTables or AutoFilters. 

 

Brainstorm learners to elicit response on some common electronic 

spreadsheet software packages.  

Example: MS Excel, Lotus 1-2-3, LibreOffice Calc, Google Sheets etc.) 

 

 

 

Reflection (10 mins) 

We have learnt the importance of electronic spreadsheet.  
 

Engage learners in a think-pair-share activity to come up with other 

importance of electronic spreadsheet. 
Homework/Project Work/Community Engagement Suggestions 

 Have learners do further reading on the importance of electronic spreadsheet. 

 Learners to differentiate between electronic spreadsheet and manual spreadsheet. 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 

 

  



Strand : Productivity Software   Week Ending: 27th MAY, 2022 

Sub Strand: Introduction to Electronic Spreadsheet Duration : 

Content Standard: B7.2.3.1. Demonstrate how to use the Spreadsheet 

(Editing Worksheets) 
Class : B7 

Indicators:   B7.2.3.1.2. Explore features of MS-Excel interface Day : 

Core competences: DL5.1: Ability to ascertain when information is needed and be able to identify, locate, evaluate and effectively use it to 

solve a problem. 

 

Activities For Learning & Assessment Resources Learners 

Resource Page 

Ref. 

Progression  

Starter (5 mins) 

 

Using questions and answers, revise the previous lesson with learners.  

 

Share performance indicators and introduce the lesson. 

 

 

Main (35 mins) 

 

Revise with learners on how to launch the Microsoft Office Excel. 

 

Show projected examples of MS-Excel interface with the aid of a projector 

or pictures.  

 

Computer with 

Microsoft Excel, 

mouse or 

touchscreen 

input device, 

projector 

Computing 

Curriculum Pg. 9-10 
Learning how to 

insert, select, delete 

and move data using 

a sample data set 



Guide learners to explore features of MS-Excel interface. 
Example: title bar, menu bar, standard and formatting toolbars, worksheet, 

workbook, column, row, range, AutoSum, etc. 

 

Learners to explore and demonstrate the functions of the features 

identified above. 

 

Explore operations of inserting, selecting, deleting and moving data.  

 

Learners explore techniques of inserting, selecting, deleting and moving data 

in groups. 

 

Demonstrate how to insert, select, delete and move data using a sample 

data set. 

 

Learners practice how to insert, select, delete and move data using a 

sample data set. 

 

 

Reflection (10 mins) 

We have learnt how to select and move data.  

 

Engage learners in a think-pair-share activity on how to use other 

techniques for moving text. 

Homework/Project Work/Community Engagement Suggestions 

 Do further reading on how to set the cell data type (General, Number, Currency, etc.) 

 Identify any six (6) features of Microsoft Excel. 

 State the function of the AutoSum in Excel 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 

 



Fayol Inc. 0547824419 

WEEKLY LESSON NOTES – B7 

WEEK 4 

Strand : Productivity Software   Week Ending : 3RD JUNE, 2022 

Sub Strand: Introduction to Electronic Spreadsheet Duration : 

Content Standard: B7.2.3.1. Demonstrate how to use the Spreadsheet 

(Editing Worksheets) 
Class : B7 

Indicators:   B7.2.3.1.3. Demonstrate how to set the cell datatype Day : 

Core competences: DL5.1: Ability to ascertain when information is needed and be able to identify, locate, evaluate and effectively use it to 

solve a problem. 

 

Activities For Learning & Assessment Resources Learners 

Resource Page 

Ref. 

Progression  

Starter (5 mins) 

 

Using questions and answers, revise the previous lesson with learners.  

 

Share performance indicators and introduce the lesson. 

 

 

Main (35 mins) 

 

Guide learners to discuss the types of data in spreadsheet. 

Example: 

Value - +23341123456 

Labels/Text – January, July, 24.04’, #3, 7th, etc. 

Formula – A7 + B7, =C4 * C5, etc. 

Function - =SUM(A5:G5), AVERAGE(B4:B5) 

 

Revise with learners on how to enter data in spreadsheet. 

Example: 

Computer with 

Microsoft Excel, 

mouse or 

touchscreen 

input device, 

projector 

Computing 

Curriculum Pg. 9-10 
Learning how to set 

and modify the cell 

type of values and 

text. 



 Click the cell where you want type information. 

 Type the data. 

 The data can either typed in the active cell or in the formula bar. 

 Click on the Enter key.  

 

Let learners investigate data entry techniques, how to set and modify the 

cell type of values and text.  

Example:  

 AutoFill – enter the first value in a recognized series and use the fill 

handle to extend the series. 

 AutoComplete – type the first few letters in a cell, and if a similar value 

exist in the same column, Excel suggests the existing value. 

 Fill series – enter the first two values in a series and use the fill handle 

to extend the series. 

 

Guide learners to enter values, text, dates and time in worksheet cells and 

change the formats for presentation. E.g. General, Number, Currency, 

Accounting, Dates, Time, etc. 

 

 

Reflection (10 mins) 

We have learnt how to select and move data.  

 

Engage learners in a think-pair-share activity on how to use other 

techniques for moving text. 

Homework/Project Work/Community Engagement Suggestions 

 State the four types of data we enter into spreadsheet. 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 

 

 



 

 

  



 

Strand : Productivity Software  Week Ending: 3RD JUNE, 2022 

Sub Strand: Introduction to Electronic Spreadsheet Duration : 

Content Standard: B7.2.3.1. Demonstrate how to use the Spreadsheet 

(Editing Worksheets) 
Class : B7 

Indicators:   B7.2.3.1.4. Demonstrate how to use Align Text, Merge & Wrap, 

Borders and Shades 

Day : 

Core competences: DL5.1: Ability to ascertain when information is needed and be able to identify, locate, evaluate and effectively use it to 

solve a problem. 

 

Activities For Learning & Assessment Resources Learners 

Resource Page 

Ref. 

Progression  

Starter (5 mins) 

 

Using questions and answers, revise the previous lesson with learners.  

 

Share performance indicators and introduce the lesson. 

 

 

Main (35 mins) 

 

Have learners demonstrate how to apply the AutoSum feature. 
Excel can make somewhat of an intelligent decision on its own and determine which cells 

of a row or column should be" summed" . This is called the AutoSum feature. 

 

To quickly add the contents of a column or row, follow the steps shown 

below: 
1.Select the cell either to the right or below the cells that are to be total ed. 

2.Double Click on the AutoSum tool ( which is located on the standard tool bar ). 

 

Guide learners to demonstrate how to change text alignment (Horizontal & 

Vertical), merge cells and wrap text.  

 

Computer with 

Microsoft Excel, 

mouse or 

touchscreen 

input device, 

projector 

Computing 

Curriculum Pg. 13-

14 

Learning how to 

change text 

alignment, merge 

cells and wrap text 



ALIGNING CELL DATA  

Unless you specify otherwise, Excel left justifies text and right justifies 

numbers. That is, text fills cell space from left to right while numbers are 

filled from right to left so that they align properly. 

 

To change the cell alignment for a single cell or a group of selected cells, 

click one of the following tools. 

 
 

 

 

 

How to merge cells 
A single cell is created by combing two or more selected cells. The cell reference for a 

merged cell is the upper left cell in the original selected range. If there is a data in other 

cells, the data is deleted. 
 Copy the data you want into the upper left most cell within the range 

 Select the cells in arrow or column and center the cell contents, click merge and center 

on the formatting toolbar. 

 

Have learners investigate how to access border & shade features and 

format the appearance of a worksheet as group work. 

 

Reflection (10 mins) 

We have learnt how to change text alignment, merge cells and wrap text.  

 

Engage learners in a think-pair-share activity on how to use other 

techniques for moving text. 

Homework/Project Work/Community Engagement Suggestions 

Describe briefly to merge cells in a spreadsheet. 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 

Left 

Center Right  

Justify  



 



Fayol Inc. 0547824419 

WEEKLY LESSON NOTES – B7 

WEEK 5 

Strand : Productivity Software  Week Ending : 10TH JUNE, 2022 

Sub Strand: Introduction to Electronic Spreadsheet Duration : 

Content Standard: B7.2.3.2. Demonstrate how to format a worksheet Class : B7 
Indicators:   B7.2.3.2.1 Demonstrate how to adjust margins and set page 
orientation 

Day : 

Core competences: DL5.1: Ability to ascertain when information is needed and be able to identify, locate, evaluate and effectively use it to 
solve a problem. 
Reference: Computing Curriculum P.g. 16 
 
Activities For Learning & Assessment Resources Learners 

Resource Page 
Ref. 

Progression  

Starter (5 mins) 
 
Using questions and answers, revise the previous lesson with learners. 
 
Share performance indicators and introduce the lesson. 
 
 
Main (35 mins) 
 
Guide learners to demonstrate how to adjust margins and set page 
orientation for printing.  
Adjusting Margins 
 On the page layout tab, click margins, and then select custom margins. 

 Use the arrows to increase or decrease the margin size in the appropriate box. When 
you are done, click Ok. 

 
Page Setup 

Computer with 
Microsoft Excel, 
mouse or 
touchscreen 
input device, 
projector 

Computing 
Curriculum Pg. 9-10 

Learning how to 
adjust margins and 
set page orientation 
for printing 



 Press CTRL and then click each worksheet tab in the workbook that you want to affect 

 On the file menu, click page setup. Click the dialog box launcher in the page setup 
group in the page layout tab. 

 Make the changes that you want in the page setup dialog box, and then click Ok. 

 
Demonstrate how to perform margin adjustment on different page sizes.  

 
 
Guide learners to explore the display of worksheets in different views as 
listed on the View tab. 
 
 
Reflection (10 mins) 
We have learnt how to adjust margins and set page orientation for printing.  
 
Engage learners in a think-pair-share activity on how to use other 
techniques for moving text. 
Homework/Project Work/Community Engagement Suggestions 

 Describe how to adjust margins for printing in Excel 

 List four tools on the Page Layout tab and give one function of each. 
Cross-Curriculum Links/Cross-Cutting Issues 
None  



Potential Misconceptions/Student Learning Difficulties 
The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 

 

 

 

 

  



 

Strand : Productivity Software  Week Ending: 10th JUNE, 2022 

Sub Strand: Introduction to Electronic Spreadsheet Duration : 

Content Standard: B7.2.3.2. Demonstrate how to format a worksheet Class : B7 
Indicators: B7.2.3.2.2. Demonstrate how to set up a header and a footer. Day : 
Core competences: DL5.1: Ability to ascertain when information is needed and be able to identify, locate, evaluate and effectively use it to 
solve a problem. 
Reference: Computing Curriculum P.g. 16 
 
Activities For Learning & Assessment Resources Learners 

Resource Page 
Ref. 

Progression  

Starter (5 mins) 
 
Using questions and answers, revise the previous lesson with learners.  
 
Share performance indicators and introduce the lesson. 
 
 
Main (35 mins) 
 
Guide learners to demonstrate to learners how to set up header and 
footer elements.  

 On the inert tab, in the text group, click Header & Footer. 

 To add or edit a header or footer text box at the top or the bottom of the 
worksheet page (under header, or above footer) 

 Type the new header or footer text. 
 
Engage learners to explore the use of page numbers, current date, time and 
file name in setting up headers and footers. 

Computer with 
Microsoft Excel, 
mouse or 
touchscreen 
input device, 
projector 

Computing 
Curriculum Pg. 13-
14 

Learning how to set 
up header and 
footer elements 



 
 
Reflection (10 mins) 
We have learnt how to set up headers and footer elements.  
 
Engage learners in a think-pair-share activity on how to use other 
techniques for moving text. 
Homework/Project Work/Community Engagement Suggestions 
Describe  briefly how to set up header and footer elements in Excel. 

Cross-Curriculum Links/Cross-Cutting Issues 
None  
Potential Misconceptions/Student Learning Difficulties 
The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 

 



Fayol Inc. 0547824419 

WEEKLY LESSON NOTES – B7 

WEEK 6 

Strand : Productivity Software  Week Ending : 17TH JUNE, 2022 

Sub Strand: Introduction to Electronic Spreadsheet Duration : 

Content Standard: B7.2.3.2. Demonstrate how to format a worksheet Class : B7 
Indicators:   B7.2.3.2.3. Demonstrate the use of the Autofill function in MS-Excel worksheet Day : 
Core competences: DL5.1: Ability to ascertain when information is needed and be able to identify, locate, evaluate and effectively use it to 
solve a problem. 
Reference: Computing Curriculum P.g. 16 
 
Activities For Learning & Assessment Resources Learners 

Resource Page 
Ref. 

Progression  

Starter (5 mins) 
 
Using questions and answers, revise the previous lesson with learners. 
 
Share performance indicators and introduce the lesson. 
 
 
Main (35 mins) 
 
Demonstrate the use of the Autofill function.  
e.g. to generate the days of the week, months of the year, set of numbers 
(e.g. counting numbers, odd numbers, multiplication tables etc.).  
 
To do this: 
 
1. Select the first cell in the range that you want to fill (e.g. A3). 
 

Computer with 
Microsoft Excel, 
mouse or 
touchscreen 
input device, 
projector 

Computing 
Curriculum Pg. 9-10 

Learning how to use 
the Autofill function 
to generate the days 
of the week, months 
of the year, set of 
numbers 



2. Type the starting value for the series (e.g. 1 in A3). 
 
3. Type a value in the next cell to establish a pattern (e.g. 2 in A4). [Tip: For 
example, if you want the series 1, 2, 3, 4, 5..., type 1 and 2 in the first two 
cells. If you want the series 2, 4, 6, 8..., type 2 and 4.] 
 
4. Select the cells that contain the values (e.g. A3 and A4) 
 
5. Drag the fill handle                      across the range that you want to fill 
(e.g. A3:A10) 

 
 

 
Again guide learners to use function to number rows or columns 
 
1. Select the first cell in the range that you want to fill. (e.g. A3) 
 
2. Type the ROW function (e.g. = ROW(A1). [The ROW function returns 
the number of the row that you reference. For example, = ROW(A1) 
returns the number 1.] 
 



3. Select the cells that contain the function (e.g. A3). 
 
4. Drag the fill handle                      across the range that you want to fill. 
(e.g. A3:A10) 

 
 
 
Reflection (10 mins) 
We have learnt how to use Autofill function to generate the days of the 
week, months of the year, set of numbers.  
 
Engage learners in a think-pair-share activity on how to use other 
techniques for moving text. 
Homework/Project Work/Community Engagement Suggestions 

 Describe how to use Autofill function to generate the days of the week, months of the year, set of numbers. 

Cross-Curriculum Links/Cross-Cutting Issues 
None  
Potential Misconceptions/Student Learning Difficulties 
The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 

 

 

 



 

 

Strand : Productivity Software  Week Ending: 17th JUNE, 2022 

Sub Strand: Introduction to Electronic Spreadsheet Duration : 

Content Standard: B7.2.3.2. Demonstrate how to format a worksheet Class : B7 
Indicators: B7.2.3.3.1. Demonstrate how to create formulas Day : 
Core competences: DL5.1: Ability to ascertain when information is needed and be able to identify, locate, evaluate and effectively use it to 
solve a problem. 
Reference: Computing Curriculum P.g. 16 
 
Activities For Learning & Assessment Resources Learners 

Resource Page 
Ref. 

Progression  

Starter (5 mins) 
 
Using questions and answers, revise the previous lesson with learners.  
 
Share performance indicators and introduce the lesson. 
 
 
Main (35 mins) 
 
Guide learners to identify and name cells in an Excel. 
A cell is named after its column letter and row number. 
Example: B4, C6, E8 
 
Guide learners to create simple formulas starting with the equal sign. 
Excel formulas makes use of the basic mathematical operations (+, -, * and /) 

A3       X  fx  
 A B C D E 
1 Name Class score Exams score Total  
2 Kojo Nkrumah 25 46 71 
3 Ama Serwaa 19 45  

Computer with 
Microsoft Excel, 
mouse or 
touchscreen 
input device, 
projector 

Computing 
Curriculum Pg. 
13-14 

Learning how to 
create simple 
formulas in Excel 



4 Efia Akoto 24 35  
5 Kofi Cash 15 34  

 

 Write formulas for cell E3, E4 and E5. 
From the table the figure in cell E2 (71) is as a results of adding 25 and 46. 
Therefore we are to use the operation sign (+).  
Now determine the cell which contains the figures 25 and 46. 
That is C2 (25) and D2 (46). 
So we can conclude that  
E2 = C2 + D2 
E3 = C3 + D3   
 

A3       X  fx  
 A B C D E 
1 Items  Selling Price Cost Price Total  
2 Milk  6 4  
3 Sugar  20 15 5 
4 Milo  50 35  
5 Gari  35 20 15 

 

 Write formulas for cell E2 and E4. 
From the table the figure in cell E3 (5) is as a results of subtracting 15 from 
20. Therefore we are to use the operation sign (-).  
Now determine the cell which contains the figures 20 and 15. 
That is C3 (20) and D3 (15). 
So we can conclude that  
E3 = C3 - D3 
 
Reflection (10 mins) 
We have learnt how to create simple formulas in Excel.  
 
Engage learners in a think-pair-share activity on how to use other techniques 
for moving text. 
Homework/Project Work/Community Engagement Suggestions 



 
 
Write formulas for cell E3, E7, E8, E9, E10 
Cross-Curriculum Links/Cross-Cutting Issues 
None  
Potential Misconceptions/Student Learning Difficulties 
The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 

 

 



Fayol Inc. 0547824419 

WEEKLY LESSON NOTES – B7 

WEEK 7 

Date: 24th JUNE, 2022 DAY:  Subject: Computing 

Duration:  Strand: Communication Networks   

Class: B7 Class Size:  Sub Strand: Computer Networks   

Content Standard:   
B7.3.1.1 Identify the concept of computer networking for 

global communications. 

Indicator:  

B7.3.1.1.1 Draw diagrams to illustrate features of the 

network topologies (Bus, Star, Ring, Mesh) 

Lesson: 

 

1 of 2 

Performance Indicator:  

Learners can draw diagrams to illustrate features of the network 

topologies 

Core Competencies: 

DL5.1: Ability to ascertain when information is needed and be able to 

identify, locate, evaluate and effectively use it to solve a problem. 

Reference: Computing Curriculum P.g. 16-18 

 

Activities For Learning & Assessment Resources Progression  

Starter (5 mins) 

 

Using questions and answers, revise the previous lesson with learners. 

 

Display pictures or show a video of people communicating using phones, text messaging, video 

conferencing, etc. Help learners understand how they are all connected to each other. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35 mins) 

 

Engage learners to explore key hardware for setting up network systems (such as server, client, 

hub, switch, cable etc.)  

Pictures of 

network 

topologies, sketch 

diagram, projector 

the various media 

through which 

people 

communicate. 

 

Identifying major 

components that 

help computers to 

communicate. 

 

Learning how to 

draw diagrams to 

illustrate features 

of the network 

topologies 



 
 

Show learners diagrams of various setups to explain network topologies.  

 

Bus – is a communication system that transfers data between components inside a computer or 

between computers. 

 
 

Star – in a star network, each computer is connected by its own cable directly to the server. 

 
 

Ring – in a ring network, all the computers are to one another in a circle. 



 
 

 

Mesh – is a network setup where each computer and network device is interconnected with 

one another. 

   
 

Let learners discuss the features of each network topology.  

 

Have learners present in groups, diagrams of well-elaborated network topologies. 

Allow learners to sketch the topologies to deepen their understanding. 

 

Reflection (10 mins) 

We have learnt how to draw diagrams to illustrate features of the network topologies. 

 

Use peer discussion and effective questioning to find out from learners what they have learnt 

during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

 Learners are to work in groups to design well-elaborated network topologies and present them in class 

 Using play dough and sticks, form/design the types of network topologies. 



 

 

 

Date: 24th JUNE, 2022 DAY:  Subject: Computing 

Duration:  Strand: Communication Networks   

Class: B7 Class Size:  Sub Strand: Computer Networks   

Content Standard:   
B7.3.1.1 Identify the concept of computer networking for 

global communications 

Indicator:  

B7.3.1.1.2 Describe types of networks. 

Lesson: 

 

2 of 2 

Performance Indicator:  

Learners can describe the types of networks. 

Core Competencies: 

DL5.1: Ability to ascertain when information is needed and be able to 

identify, locate, evaluate and effectively use it to solve a problem. 

Reference: Computing Curriculum P.g. 16-18 

 

Activities For Learning & Assessment Resources Progression  

Starter (5 mins) 

 

Using questions and answers, revise the previous lesson with learners. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35 mins) 

 

Brainstorm learners for the meaning of Network. 

A network is the collection of two or more computers and hardware components that are linked together such as 

that they can communicate using wire or wireless technology. 

 

Have learners discuss the two forms of network. 

 

 Wired network is a network that uses network cables or wires to connect the computers in the network. It is 

called Cable Network. 

 Wireless Network – this doesn’t not use wires or cables to connect computers in a network. It uses wireless 

technologies such as GPRS, EDGE, WIFi, WiMax, HSPA, infrared and Bluetooth. 

 

Pictures of 

network 

topologies, sketch 

diagram, projector 

Describing the  

types of networks 



Guide learners to explain the various types of networks available. (e.g. PAN, LAN, MAN, WAN, 

WLAN, INTERNET, etc.) 

 

 The International Network (Internet) : Internet is a global network connecting millions of computers 

that communicate using wire or wireless technology. 
 

 Local Area Network (LAN): Is a network of computers that are geographical close together (in a 

single building) such as school building, computer laboratory, office building, etc. 
 

 Wide Area Network (WAN): Is a combination of two or more Local Area Networks (LANs). The 

computers are farther apart and are connected by telephone lines or radio waves. 

 

 Personal Area Network (PAN) is the network around a person for his/her personal use. PAN  

involves the use of USB cables, Bluetooth or Infrared in connecting the computers for 

communication. 

 

 Home Area Network (HAN) is the network of digital devices in a user's home. Devices may  

include computer, printer, mobile devices, game consoles, remote control, etc. 

 

 Campus Area Network (CAN) is a network within a limited geographical area such as university  

campus, company, government agency, etc. 

 

 Metropolitan Area Network (MAN) is a network that spans a city or a metropolitan area.  

 

 Intranet is a restricted private network within an organization that is only used by authorized users. 

 

 Extranet is a private network of an organization or company or bank that can be accessed by  

customers. It uses Internet technology to securely share part of a business's information or  

operations with suppliers, vendors, partners, customers or other businesses. 
 

 

Reflection (10 mins) 

We have learnt the types of networks. 

 

Use peer discussion and effective questioning to find out from learners what they have learnt 

during the lesson. 

 

Take feedback from learners and summarize the lesson. 



Homework/Project Work/Community Engagement Suggestions 

 What is Network? 

 Differentiate between wired and wireless network. 

 Explain the following terms 

PAN, WLAN, WAN, LAN. 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 

 

 



Fayol Inc. 0547824419 

WEEKLY LESSON NOTES – B7 

WEEK 8 

Date: 1ST JULY, 2022 DAY:  Subject: Computing 

Duration:  Strand: Communication Networks   

Class: B7 Class Size:  Sub Strand: Computer Networks   

Content Standard:   
B7.3.1.1 Identify the concept of computer networking for 
global communications. 

Indicator:  

B7.3.1.1.3 Discuss the entrepreneurial opportunities in 
networking computing devices 

Lesson: 
 
1 of 2 

Performance Indicator:  

Learners can describe the benefits and challenges of networking in 
different environments 

Core Competencies: 

DL5.1: Ability to ascertain when information is needed and be able to 
identify, locate, evaluate and effectively use it to solve a problem. 

Reference: Computing Curriculum P.g. 16-18 

 
Activities For Learning & Assessment Resources Progression  
Starter (5 mins) 
 
Using questions and answers, revise the previous lesson with learners. 
 
Display pictures or show a video of people communicating using phones, text messaging, video 
conferencing, etc. Help learners understand how they are all connected to each other. 
 
Share performance indicators and introduce the lesson. 
 
 
Main (35 mins) 
 
Guide learners to discuss the benefits of networking in different environments (school, business, 
health, etc.).  
 
Benefits 
1. Ease of accessibility 
Modern computer networks are easy to explore. So, even if you are a kid or a person new to technology, you'll find it easy to 

connect.  

Pictures of 
network 
topologies, sketch 
diagram, projector 

Identifying the 
benefits and 
challenges of 
networking in 
different 
environments 



2. Flexibility 
Here, flexibility means that different people will be able to explore different things as per their requirements. For this purpose, 
computer networks provide you a wide array of choices to share a particular piece of information. For example, e-mail or 
messaging apps like WhatsApp. So, there is flexibility for different users. 
 
3. Convenient resource sharing 
The main aim of a computer network is to enable sharing of resources among its users. You can use resources such as printers, 
scanners and photocopy machines that can be shared across multiple users. This resource sharing is important for big 
companies as they can use one single common network for connecting with their employees.  
 
4. Connectivity 
Computer Networks improve connectivity irrespective of a person's location. In these testing times, we can see live examples as 
we use video call apps or Google documents to connect with our friends and colleagues.  
 
5. Security 
Computer networks provide security through authorization. Authorization is done via user id and password. So, it ensures that 
when we log in, we are only able to do it when there is a perfect match between our details and the details stored in the data 
VVVVVbase.  

 
6. Great storage capacity 
Organizations have an abundance of data that needs to be stored. For that purpose, they are required to store them in a central 
server. A central server is a remote server that is accessible to each and every employee. So, if in case one loses the data, others 
have it.  
 
 7. Reduced cost 
Cost is one of the crucial factors that one needs to consider while evaluating the pros and cons of a particular technology. In 

networking, a central server is used that enables companies to store files in one place and thus reducing file storage expenses. 

 
Guide learners to discuss the challenges of networking in different environments (school, 
business, health, etc.).  
 
Challenges 
1. Lack of robustness 
Computer networks rely on the main server called the central server. If the central server malfunctions or there is an issue in the 
central server, then the entire network would stop functioning. So, this is a major disadvantage due to dependency on a single 
server. 
 
2. Spread of computer virus 
As computers in a network are interconnected, there is a high probability that if one of the computers is affected by the virus, 
others too can get affected. This spread can actually damage the entire system. Also, if the central server gets corrupted, then 
it's quite dangerous as the network depends on the central server. 
 
3. Independence issues 
The entire networking system is based on a centralized server, so it lacks independence. So, individual users lack the freedom to 
use the computer as per their wish. 



4. Lack of productivity 
Since a network has a lot of advantages and applications, it is certain that it results in simultaneous use of many services that 
cause distraction. Thus, due to employees focusing on a myriad of tasks, productivity issues are quite common.  
 
5. Health issues 
Computer network provides access to a gamut of services including entertainment, gaming, and movies. These result in making 
you addicted to the content and thus results in overuse of these services. This excessive screen time makes you feel lethargic, 
causes eye strain and body pain. 

 
 
 
Reflection (10 mins) 
We have learnt the benefits and challenges of networking in different environments. 
 
Use peer discussion and effective questioning to find out from learners what they have learnt 
during the lesson.  
 
Take feedback from learners and summarize the lesson. 
Homework/Project Work/Community Engagement Suggestions 

  

Cross-Curriculum Links/Cross-Cutting Issues 
None  
Potential Misconceptions/Student Learning Difficulties 
The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 

 

 

  



 

Date: 1ST JULY, 2022 DAY:  Subject: Computing 

Duration:  Strand: Communication Networks   

Class: B7 Class Size:  Sub Strand: Computer Networks   

Content Standard:   
B7.3.1.1 Identify the concept of computer networking for 
global communications 

Indicator:  

B7.3.1.1.4 Identify different environments where the 
various types of networks can be applied. 

Lesson: 
 
2 of 2 

Performance Indicator:  

Learners can describe different environments where the various 
types of networks can be applied 

Core Competencies: 

DL5.1: Ability to ascertain when information is needed and be able to 
identify, locate, evaluate and effectively use it to solve a problem. 

Reference: Computing Curriculum P.g. 16-18 

 
Activities For Learning & Assessment Resources Progression  
Starter (5 mins) 
 
Using questions and answers, revise the previous lesson with learners. 
 
Share performance indicators and introduce the lesson. 
 
 
Main (35 mins) 
 
Guide learners to identify different environments where the various types of networks can be 
applied. 
  
 Marketing and sales: – Computer networks are widely used in both marketing sales firms. These are used by 

marketing professionals to collect, exchange, and analyzes data relating to customer requirements and product 
development cycles. Teleshopping is also important part of sales applications that use order-entry computers or 
telephones connected to an order-processing network, and on-line reservation services for hotels airline and so 
on. 

 Manufacturing: – Now days, computer networks are used in a several aspects of manufacturing, including the 
manufacturing process itself. Two applications which use a network to provide necessary services are computer-
assisted manufacturing (CAM) and computer –assisted designing (CAD) both of which permit multiple users to 
work on a project simultaneously. 

 Financial Services: – In Present, Financial services are completely dependent on computer networks. Main 
applications are credit history searches, foreign exchange and investment services, and Electronic Funds 
Transfer (EFT) that permits a user to transfer money without going into bank. 

Pictures of 
network 
topologies, sketch 
diagram, projector 

Identifying different 
environments where 
the various types of 
networks can be 
applied. 
 



 Teleconferencing: – With The help of teleconferencing conferences are possible to occur without the 
participants being in the same place. Applications include simple text conferencing, voice conferencing, and 
video conferencing. 

 Cable Television:-Future Services provided by cable television network can include video on request, as well as 
the same information, financial and communications services currently provided by the telephone companies 
and computer networks. 

 Information Services:- Network information services include bulletin boards and data banks. A World Wide 
Web site offering the technical specifications for a new product is an information service. 

 Electronic Messaging:– Electronic mail (e-mail) is the most widely used network application. 

 Electronic Data Interchange (EDI):– EDI permits business information to be transferred without using paper. 

 Directory services: – By using directory services, it is possible to store the last of files in a central location to 
speed worldwide search operations. 

 Cellular Telephone: – In the past, two parties desiring to use the services of the telephone company had to be 
linked by a fixed physical connection. But, in present cellular network make it possible to maintain wireless 
phone connections even while travelling over large distances. 

 
 
In groups, task learners to identify the business aspect of networking and how they can be 
turned into a lucrative business. 
 
Have them to present their findings to the whole class. 
 

 
Reflection (10 mins) 
We have learnt the different environments where the various types of networks can be applied. 
 
Use peer discussion and effective questioning to find out from learners what they have learnt 
during the lesson. 
 
Take feedback from learners and summarize the lesson. 
Homework/Project Work/Community Engagement Suggestions 

 Identify 5 environments where the various types of networks can be applied 

Cross-Curriculum Links/Cross-Cutting Issues 
None  
Potential Misconceptions/Student Learning Difficulties 
The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 

 

 



Fayol Inc. 0547824419 

WEEKLY LESSON NOTES – B7 

WEEK 9 

Date: 8th JULY, 2022 DAY:  Subject: Computing 

Duration:  Strand: Communication Networks   

Class: B7 Class Size:  Sub Strand: Internet and Social Media   

Content Standard:   
B7.3.2.1 Demonstrate the use of Social Networking and 

Electronic Mail. 

Indicator:  

B7.3.2.1.1 Identify the various types and uses of Social 

Media sites such as those for Social Networking 

Lesson: 

 

1 of 2 

Performance Indicator:  

Learners can describe uses of Social Media sites 

Core Competencies: 

DL5.1: Ability to ascertain when information is needed and be able to 

identify, locate, evaluate and effectively use it to solve a problem. 

Reference: Computing Curriculum P.g. 16-18 

 

Activities For Learning & Assessment Resources Progression  

Starter (5 mins) 

 

Using questions and answers, revise the previous lesson with learners. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35 mins) 

 

Guide learners to Illustrate the use of social networking sites such as Facebook, LinkedIn, 

WhatsApp, etc.  

Pictures and videos  Identifying uses of 

Social Media sites 



 
 
Facebook is a website which allows users, who sign-up for free profiles, to connect with friends, work colleagues or 

people they don’t know, online. It allows users to share pictures, music, videos, and articles, as well as their own 

thoughts and opinions with however many people they like. 

Users send “friend requests” to people who they may – or may not – know. Facebook has over 1 billion users 

Once accepted, the two profiles are connected with both users able to see whatever the other person posts. 

“Facebookers” can post almost anything to their “timeline”, a snapshot of what is happening in their social circle at 

any given time, and can also enter private chat with other friends who are online. 

Guide learners to discuss ways of staying safe with using Facebook. 

Example: Terms of service and privacy policy. 

 

Guide learners to Illustrate the use of social networking sites such as LinkedIn and access its 

importance WhatsApp 
LinkedIn is a social network that focuses on professional networking and career development. 

You can use LinkedIn to display your resume, search for jobs, and enhance your professional reputation by posting 

updates and interacting with other people.  

LinkedIn is free, but a subscription version called LinkedIn Premium offers additional features like online classes and 

seminars, as well as insights into who's searching for and viewing your profile 
 

Importance 

A well written LinkedIn profile will give you credibility and establish you as a trustworthy 

potential employee. Every time a recruiter contacts you, you can be sure that they have looked 

at your profile. 

 

Guide learners to Illustrate the use of social networking sites such as WhatsApp and access its 

importance. 
 

WhatsApp is free to download messenger app for smartphones. WhatsApp uses the internet to send messages, 

images, audio or video. The service is very similar to text messaging services, however, because WhatsApp uses the 

internet to send messages, the cost of using WhatsApp is significantly less than texting.  



To use WhatsApp you need a compatible smartphone or tablet with a sim card, an internet connection, and a 

phone number. The app uses your phone number as its username, and your account is locked to the phone, 

although you can transfer your contacts over to new devices 

 

Importance 

 Stimulates a dynamic learning environment 

 Facilitates rich interactions and 24×7 learning even outside the classroom 

 Encourages real-time communication between teachers and students, and teachers and parents 

 Fosters collaboration between students so they can learn better together 

 Share educational resources to match the learning styles and needs of different students 

 A familiar, comfortable interface that students love to use for learning 

 

 

Reflection (10 mins) 

We have learnt the uses of Social Media sites 

 

Use peer discussion and effective questioning to find out from learners what they have learnt 

during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

 Write four importance of facebook and WhatsApp. 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 

 

  



Date: 8th JULY, 2022 DAY:  Subject: Computing 

Duration:  Strand: Communication Networks   

Class: B7 Class Size:  Sub Strand: Internet and Social Media   

Content Standard:   
B7.3.2.1 Demonstrate the use of Social Networking and 

Electronic Mail. 

Indicator:  

B7.3.2.1.1 Identify the various types and uses of Social 

Media sites such as those for Social Networking 

Lesson: 

 

2 of 2 

Performance Indicator:  

Learners can describe how microblogging platforms works. 

Core Competencies: 

DL5.1: Ability to ascertain when information is needed and be able to 

identify, locate, evaluate and effectively use it to solve a problem. 

Reference: Computing Curriculum P.g. 16-18 

 

Activities For Learning & Assessment Resources Progression  

Starter (5 mins) 

 

Using questions and answers, revise the previous lesson with learners. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35 mins) 

 

Brainstorm learners for the meaning of microblogging. 

Is an online broadcast medium that exists as a specific form of blogging. Microblogging is a 

combination of instant messaging and content production 

 
Using pictures, learners discuss some examples of microblogging. 

Examples: Tumblr, Medium, Blogger, Instagram, twitter, Pinterest, etc. 

 

Pictures and videos  Identifying how 

microblogging 

platforms works 



Demonstrate the use of microblogging platforms. 
Tumblr  

is a blogging and social media tool that allows users to publish a "tumblelog", or short blog posts. Tumblr's 

major differentiator is the free-form nature of the site and the ability of users to heavily customize their 

own pages. This is the exception to the rule, as nearly all other social networks have standardized profile 

pages with limited design flexibility. 

 

How is Tumblr used? 

Getting a page set up on Tumblr is similar to other social media networks. Users sign up for an account by 

providing an email address as well as creating a password, username and a URL for the page. 

 

Twitter 

Twitter is a free social networking site where users broadcast short posts known as tweets. These tweets 

can contain text, videos, photos or links. To access Twitter, users need an internet connection or smart 

phone to use the app or website, Twitter.com. It is a microblogging service -- a combination of blogging 

and instant messaging -- for registered users to post, share, like and reply to tweets with short messages. 

Nonregistered users can only read tweets. 

 

How Twitter works 

Users choose what they want to see on Twitter by following other users and companies and searching 

topics. Generally, the timeline reflects the users' preferences, but they may see retweets from people they 

follow and promoted Tweets, which are paid advertisements 

 

 

Reflection (10 mins) 

We have learnt how microblogging platforms works 

 

Use peer discussion and effective questioning to find out from learners what they have learnt 

during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

State and explain how four of the microblogging platforms works 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 

 



Fayol Inc. 0547824419 

WEEKLY LESSON NOTES – B7 

WEEK 10 

Date: 15th JULY, 2022 DAY:  Subject: Computing 

Duration:  Strand: Communication Networks   

Class: B7 Class Size:  Sub Strand: Internet and Social Media   

Content Standard:   
B7.3.2.1 Demonstrate the use of Social Networking and 
Electronic Mail. 

Indicator:  

B7.3.2.1.2 Demonstrate the use of the following features 
of Electronic mail: Attachment and Address book 

Lesson: 
 
1 of 2 

Performance Indicator:  

Learners can Demonstrating how to compose and send email messages 

Core Competencies: 

CI 6.3: DL5.1:  

Reference: Computing Curriculum P.g. 16-18 

 
Activities For Learning & Assessment Resources Progression  
Starter (5 mins) 
 
Using questions and answers, revise the previous lesson with learners. 
 
Share performance indicators and introduce the lesson. 
 
 
Main (35 mins) 

 
Revise with learners on some ways of sharing information. 
Example: 

E-mail with/without Attachments 
 

 
 

 
Brainstorm learners for the meaning of Email. 
Email is a network communication system used to transmit messages from one networked computer to 
another over the Internet. 
 

Pictures and videos  Demonstrating 
how to compose 
and send email 
messages. 



Demonstrate the steps involved in logging in into an email account. 
Log In is the process by which an individual gains access to a computer system or a website by identifying 
and authenticating themselves with a username and a password. Log In is also known as Log On or Sign 
In. 
 
How to Sign In / Log Into E-mail Account  
 
1. Open your e-mail service log in webpage (mail ISP). E.g. www.gmail.com or www.ymail.com  
2. Type your e-mail username or user ID. 
3. Type your password.  
4. Click on Sign In or press Enter key to launch your e-mail account. 
 

 
 
Guide learners to describe some terminologies in relation to email. 

 From: is the location where the sender’s email address is inserted. 

 To: is the location where the original recipient(s) email address(es) is/are inserted. 

 Carbon copy (Cc) is used to send the same information to other recipients apart from 
the original recipient. 

 Blind carbon copy (Bcc) is used to secretly send the same information to other 
recipients. 



 Subject is the location where the title/theme of the email message is inserted before 
sending a message. 

 

 
 
Guide learners to demonstrate the steps in creating and sending email.  
To compose email means to create a message in the form of text entered from the keyboard with or 

without an attachment. 
 
Composing E-mail Messages 
 
 Log into your e-mail account. 

 Click the Create Mail (compose) button . The New Message window appears. 

 Type the recipient’s e-mail address or add recipient from your Address Book in the To: box . 

 To send a copy of a message to someone, click in the Cc: field and/or the Bcc: field and repeat Steps 3 
to enter their e-mail addresses. 

 Click the Subject field and enter a subject for the e-mail.  

 Click the Message Body, in the lower pane, then type the message as you would in a word processor. 

 To send a file or picture along with your message click the Attach button on the toolbar and then 
select the file in the Insert Attachment dialog box. 

 When you’re finished with the message, click the Send Message button on the toolbar.  
 A confirmation will be sent to Outbox 

 Click on ‘sign out’ to close page. 

 
 
 

Reflection (10 mins) 



We have learnt how to compose and send email messages. 
 
Use peer discussion and effective questioning to find out from learners what they have learnt 
during the lesson.  
 
Take feedback from learners and summarize the lesson. 
Homework/Project Work/Community Engagement Suggestions 

 Describe how to compose and send email messages 

Cross-Curriculum Links/Cross-Cutting Issues 
None  
Potential Misconceptions/Student Learning Difficulties 
The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 

 

  



 

Date: 15th JULY, 2022 DAY:  Subject: Computing 

Duration:  Strand: Communication Networks   

Class: B7 Class Size:  Sub Strand: Internet and Social Media   

Content Standard:   
B7.3.2.1 Demonstrate the use of Social Networking and 
Electronic Mail. 

Indicator:  

B7.3.2.1.2 Demonstrate the use of the following features of 
Electronic mail: Attachment and Address book 

Lesson: 
 
2 of 2 

Performance Indicator:  

Learners can demonstrate how to receive and reply and forward email. 
Core Competencies: 

CI 6.3: DL5.1:  

Reference: Computing Curriculum P.g. 16-18 

 
Activities For Learning & Assessment Resources Progression  
Starter (5 mins) 
 
Using questions and answers, revise the previous lesson with learners. 
 
Share performance indicators and introduce the lesson. 
 
 
Main (35 mins) 

 
Guide learners to demonstrate the steps in receiving email. 
 
To Read/Access or Check Your Malls Messages 
 

 Log on to your search engine. (e.g. yahoo.mail.com/yahoo.co.uk) 

 Click on mail and wait for it to open 

 Type your user name (ID) and password in box provided. 

 Click "Sign In or press the enter key. 

 Go to your box by clicking Inbox/Checkmall  

 Click on the massage in your box that you want to read (preferably the subject of the mail). 

 Click on segment to close you mail. 

 If a message has one or more files attached to it, a paper clip will also appear in this area. To open any 
file attached to a message, click the paper clip icon and then click the file you want to open from the 
list that appears from the paper clip. 

Pictures and videos  Demonstrating 
how to receive and 
reply and forward 
email. 



 Using Reading Pane, click the Previous and Next buttons on the toolbar to access previous and next 
e-mail messages in the Inbox.  

 Any new, unread message appear in bold and have a closed envelop icon next to them. 
 

 
Once you have read the message you can;  

 reply straight away to author, 
 forward he message to someone else or  
 delete the message. 

 
Guide learners to demonstrate replying to and forwarding email  
Reply to an Email 
When reading your email, you will notice another series of commands. Click on Reply. This will 
take you to the Compose screen, where you can compose (write) your reply on top of the 
message received. 
 
Replying E-mail Messages 
1. Find and open the message you want to reply to. 
  
2. Click the reply option you want to use: Reply to Author or Reply to All .  
 
3. Type your reply in the message body above the email message you’re replying. 
 



4. To send a file or picture along with your message click the Attach button on the toolbar and then select 
the file in the Insert Attachment dialog box.  
 
5. Click the Send button on the toolbar when you’re finished.  
 

Forward an E-mal 
Another command is to forward an email. You might do this if you have received some 
information you want to share with another person who did not receive the message. Click on 
the Forward command. This will take the message you want to forward to the compose screen. 
You can then write in the address of the person whom you wish to forward the email to When 
you forward an email, you still retain a copy for yourself. 
 
 
Have learners to demonstrate, giving reasons for using From:, To: cc:, bcc: and subject features 
when sending an email. 
 
 
 

Reflection (10 mins) 

We have learnt to reply and forward email 
 
Use peer discussion and effective questioning to find out from learners what they have learnt 
during the lesson.  
 
Take feedback from learners and summarize the lesson. 
Homework/Project Work/Community Engagement Suggestions 

 describe how to access and reply email messages. 

Cross-Curriculum Links/Cross-Cutting Issues 
None  
Potential Misconceptions/Student Learning Difficulties 
The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 

 



Fayol Inc. 0547824419 

WEEKLY LESSON NOTES – B7 

WEEK 11 

Date: 22nd JULY, 2022 DAY:  Subject: Computing 

Duration:  Strand: Communication Networks   

Class: B7 Class Size:  Sub Strand: Information Security   

Content Standard:   
B7.3.3.1. Recognize data threats and means of protection 

Indicator:  

B7.3.3.1.1 Discuss the key principles of information 
security  

Lesson: 
 
1 of 2 

Performance Indicator:  

Learners can describe the principles of information security. 
Core Competencies: 

CI 6.3: DL5.1:  

Reference: Computing Curriculum P.g. 18-20 

 
Activities For Learning & Assessment Resources Progression  
Starter (5 mins) 
 
Using questions and answers, revise the previous lesson with learners. 
 
Share performance indicators and introduce the lesson. 
 
 
Main (35 mins) 
 
Brainstorm learners to explain the meaning of information security. 
Information security covers the tools and processes that organizations use to protect information. 

  
Research in pairs the key principles of information security.  
Example: confidentiality, integrity and availability 
 
Guide learners to discuss the three key principles of information security.  
Confidentiality 
Confidentiality measures are designed to prevent unauthorized disclosure of information. The purpose of 
the confidentiality principle is to keep personal information private and to ensure that it is visible and 
accessible only to those individuals who own it or need it to perform their organizational functions. 

Pictures and videos  Describing the 
principles of 
information 
security. 



 
Integrity 
Consistency includes protection against unauthorized changes (additions, deletions, alterations, etc.) to 
data. The principle of integrity ensures that data is accurate and reliable and is not modified incorrectly, 
whether accidentally or maliciously. 
 
Availability 
Availability is the protection of a system’s ability to make software systems and data fully available when a 
user needs it (or at a specified time). The purpose of availability is to make the technology infrastructure, 
the applications and the data available when they are needed for an organizational process or for an 
organization’s customers. 
 
 
Guide learners to research and analyze scenarios involving information security. 
Example: 
Bob, driving down a main street in his patrol car notices smoke coming out of a warehouse. His partner, Alice, 
reports the emergency from her car. Alice enters the address of the building, a brief description of its location (i.c., 
north west corner), and an emergency level.  
 
In addition to a fire unit, she requests several paramedic units on the scene given that area appear to be relatively 
busy. She confirms her input and waits for an acknowledgment. 
 
John, the Dispatcher, is alerted to the emergency by a beep of his workstation. He reviews the information 
submitted by Alice and acknowledges the report. He allocates a fire unit and two paramedic units to the Incident 
site and sends their estimated arrival time (ETA) to Alice. 
 

Alice received the acknowledgment and the ETA. 
 
 
 
 

Reflection (10 mins) 

We have learnt the key principles of information security. 
 
Use peer discussion and effective questioning to find out from learners what they have learnt 
during the lesson.  
 
Take feedback from learners and summarize the lesson. 
Homework/Project Work/Community Engagement Suggestions 



 Identify and explain the key principles of information security 

Cross-Curriculum Links/Cross-Cutting Issues 
None  
Potential Misconceptions/Student Learning Difficulties 
The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 

 

  



 

Date: 22nd JULY, 2022 DAY:  Subject: Computing 

Duration:  Strand: Communication Networks   

Class: B7 Class Size:  Sub Strand: Information Security   

Content Standard:   
B7.3.3.1. Recognize data threats and means of protection 

Indicator:  

B7.3.3.1.2 Explore the legal issues regarding intellectual 
property rights  

Lesson: 
 
2 of 2 

Performance Indicator:  

Learners can discuss legal issues regarding intellectual property rights 
Core Competencies: 

CI 6.3: DL5.1:  

Reference: Computing Curriculum P.g. 18-20 

 
Activities For Learning & Assessment Resources Progression  
Starter (5 mins) 
 
Using questions and answers, revise the previous lesson with learners. 
 
Share performance indicators and introduce the lesson. 
 
 
Main (35 mins) 
 
Brainstorm learners to explain the following terms.. 
Intellectual Property (IP): Intellectual Property (IP) is the property that is as a result of the creativity of 
the mind of a person.  
 
Intellectual Property Right (ILR) : Intellectual Property Right is the exclusive right given to inventors for 
their Intellectual Property. It is also the exclusive right given to inventors on the production, sale, hiring, 
etc. of the things they have invented. 
 
Guide learners to discuss the types of Intellectual Property. 

 
 

 
 

 

Pictures and videos  Demonstrating 
how to compose 
and send email 
messages. 



guide learners to differentiate between the various legal issues mentioned.  
(e.g. Copyright, Patent, Trademark, Piracy, Copyright Infringement) 
Trademark 
Trademark is formally registered name, word, logo, symbol or image that is used to identify the manufacturer or 
distributor of products or services. The symbol for trademark is Tm or ®. 

 
Patent 
Patent is an exclusive right given to inventors to manufacture, use or sell inventions for limited period of 
time.  
 
Piracy: Piracy is the unauthorized copying and distribution of copyrighted materials. A person who is copying and 
distributing without authorization is a PIRATE. Pirates produce the counterfeits of  the original materials and sell 

them at low prices.  
 
Plagiarism: Plagiarism is the taking of someone's work or idea and claiming it as your own. It is a criminal act and 

is punishable under the copyright laws of Ghana.  
 
Copyright  
Copyright is the legal right given to inventors of original works on the use, production, reproduction, rental and sale 
of their works. In other words, it’s the right that does not allow individuals to copy intellectual property of the 
original owner. It controls the production of intellectual property right. 
 
Copyright Infringements  
Copyright infringement is an act of reproducing, copying, imitating, selling, distributing, using, exhibiting, etc. a 

copyright product or material without permission from the inventor. 
 
Guide learners to discuss issues pertaining to copyright (e.g. freeware, shareware, crippleware).  
Freeware is software, most often proprietary, that is distributed at no monetary cost to the end user. There is no 
agreed-upon set of rights, license, or EULA that defines freeware unambiguously; every publisher defines its own 

rules for the freeware it offers. 
 
Shareware is software that is distributed free on a trial basis with the understanding that the user may need or 
want to pay for it later. Some software developers offer a shareware version of their program with a built-in 
expiration date (after 30 days, the user can no longer get access to the program. 
 
Crippleware has been defined in realms of both computer software and hardware. In software, crippleware 
means that "vital features of the program such as printing or the ability to save files are disabled until the user 
purchases a registration key". 
 



 
Guide learners to discuss the consequences associated with breaking these laws. 
 
Reasons for Copyright Protection (Laws)  

 To encourage people to be innovative and invent new things.  

 To ensure that inventors gain financial benefits from their hard work.  

 To increase the revenue of the Nation as it is easy to tax copyrighted materials.  

 To protect the works of inventors.  

 To promote development because new things will always be produced.  
 

Consequences of Breaking Copyright Laws 

 Fine, imprisonment or both on the culprits / offenders.  

 Confiscation of items. 

 Discourages people from inventing new things.  

 Inventors lose financial rewards from their inventions.  

 Government loses revenue in the form of taxes and levies.  
 
 

Reflection (10 mins) 

We have learnt how to compose and send email messages. 
 
Use peer discussion and effective questioning to find out from learners what they have learnt 
during the lesson.  
 
Take feedback from learners and summarize the lesson. 
Homework/Project Work/Community Engagement Suggestions 

 What is copyright law? 

 Identify any four importance of the copyright law 

 State four consequence of copyright infringement.  
Cross-Curriculum Links/Cross-Cutting Issues 
None  
Potential Misconceptions/Student Learning Difficulties 
The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 

 

 



Fayol Inc. 0547824419 

WEEKLY LESSON NOTES – B7 

WEEK 12 

Date: 29th JULY, 2022 DAY:  Subject: Computing 

Duration:  Strand: Communication Networks   

Class: B7 Class Size:  Sub Strand: Information Security   

Content Standard:   
B7.3.3.1. Recognize data threats and means of protection 

Indicator:  

B7.3.3.1.3 Evaluate information security forensic auditing 
and criminal laws against offenders 

Lesson: 
 
1 of 2 

Performance Indicator:  

Learners can describe the criminal laws against offenders of information 
security. 

Core Competencies: 

CI 6.3: DL5.1:  

Reference: Computing Curriculum P.g. 20 

 
Activities For Learning & Assessment Resources Progression  
Starter (5 mins) 
 
Using questions and answers, revise the previous lesson with learners. 
 
Share performance indicators and introduce the lesson. 
 
 
Main (35 mins) 
 
Engage learners to watch a video of how offenders of data security breach are identified.  
 
Guide learners to discuss the laws protecting data and the applicable sanctions for their breach. 
Identify some common occurrences of data security breaches that people in the community 
overlook and their corresponding sanctions. 
 
 

Reflection (10 mins) 

Pictures and videos  Evaluating 
information 
security forensic 
auditing and 
criminal laws 
against offenders. 



Use peer discussion and effective questioning to find out from learners what they have learnt 
during the lesson.  
 
Take feedback from learners and summarize the lesson. 
Homework/Project Work/Community Engagement Suggestions 

 Identify and explain criminal laws against offenders of information security. 

Cross-Curriculum Links/Cross-Cutting Issues 
None  
Potential Misconceptions/Student Learning Difficulties 
The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 

 

 


